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1. Introduction to the Seminary Style Guide  

1.1 The Purpose of the Style Guide  

The purpose of this guide is to provide instructions on how to write and format papers for 

WRS students. The guide addresses research writing and style guidelines for research papers 

(including book reviews and bibliographies) and master’s theses. 

The guidelines in this manual apply to the majority of the papers you will write while in 

seminary. In addition to research papers, some courses include other types of writing 

assignments. Consult with your professors to find out if there are specific style requirements for 

other types of papers.  

1.2 Style in the Field of Biblical/Theological Studies  

Style guidelines vary from one field to the next, and even within a given field, multiple 

resources are available, often resulting in confusion for students. In the field of 

biblical/theological studies, the Society of Biblical Literature (SBL) has captured a set of 

principles for biblical/theological publications in The SBL Handbook of Style.1 The authors of the 

SBL handbook base their approach on the well-established principles of the Chicago Manual of 

Style (also known as CMS, CMOS, or simply “Chicago style”).2  

CMS is quite detailed and offers an invaluable set of guidelines and information on 

writing, editing, and publishing issues. As detailed as it is, CMS does not address certain issues 

specific to the field of biblical/theological studies. For example, while CMS offers some 

guidance on style matters related to Hebrew and Greek, it does not address the other ancient 

languages that are often the focus of biblical scholars, such as Aramaic, Ugaritic, or Akkadian. 

Similarly, CMS addresses some issues related to English versions of the Bible, but it does not 

provide information about numerous other ancient texts, such as the Dead Sea Scrolls. The SBL 

handbook fills in those gaps, adding the nuances of this specialized field to the general style of 

CMS. For this reason, students are encouraged to purchase both the SBL handbook and CMS. 

 
1 The Society of Biblical Literature, The SBL Handbook of Style, Ed. Gonzales Rubio et al., 2nd ed. 

(Atlanta: SBL Press, 2014). 

2 University of Chicago Press, The Chicago Manual of Style, 17th ed. (Chicago: The University of Chicago 

Press, 2017). 
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SBL addresses biblical/theological studies issues that CMS does not cover, but many other 

matters of style which are not discussed at all in SBL are included in CMS.  

Students may also wish to purchase Kate Turabian’s A Manual for Writers of Research 

Papers, Theses, and Dissertations.3 This work is also based on CMS, but it focuses specifically 

on matters related to student research writing. Similarly, the Society of Biblical Literature 

provides a “Student Supplement” to the SBL handbook to offer students guidance for 

biblical/theological studies research papers.  

Although these guides include a great deal of information for writers, certain standards 

are still set by individual publishers for publications and by individual academic institutions for 

research papers and theses. Therefore, the WRS Style Guide is written specifically to establish 

the requirements for the seminary program here at WRS. This guide will not address all the 

details that are already covered in the previously mentioned works. Instead, it will clarify for 

students which guidelines to use for the papers they will write for this program.  

For anything not addressed in this style guide, students should first consult the SBL 

handbook. If the answer is not found in the SBL handbook, students should then consult CMS, 

the SBL student supplement,4 or Turabian’s manual. Additional resources for students will be 

provided throughout this guide and listed again at the end in Appendix C.  

 
3 Kate L. Turabian, A Manual for Writers of Term Papers, Theses and Dissertations, rev. Wayne C. Booth 

et al., 9th ed. (Chicago: University of Chicago Press, 2018). 

4 “Student Supplement to The SBL Handbook, Second Edition,” updated 2015: https://www.sbl-

site.org/assets/pdfs/pubs/SBLHSsupp2015-02.pdf  

https://www.sbl-site.org/assets/pdfs/pubs/SBLHSsupp2015-02.pdf
https://www.sbl-site.org/assets/pdfs/pubs/SBLHSsupp2015-02.pdf
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2. Research Papers  

2.1 General Information & Resources  

Students will typically write one major research paper on biblical or theological topics in 

the major content courses of the seminary program such as New Testament Studies, Old 

Testament Narratives and Prophetic Literature, and Introduction to Biblical Counseling. Students 

will also write several smaller research papers in the remainder of the Old Testament Studies 

courses. Research papers, including bibliographies and book reviews, will be part of the course 

requirements for Historical Theology, and Interdepartmental Studies.  

Again, students should consult with their professors to confirm which guidelines to 

follow for specific assignments other than research papers. Before you begin any writing 

assignment for the program, read the instructions several times to make sure you understand the 

requirements. If you have any questions about the assignment, reach out to the professor early to 

get clarification on the goals and parameters for the assignment. Your professor will advise you 

on submission guidelines such as hard copy or digital, as well as what formats for digital files are 

acceptable. 

2.2 Standard Formatting for Research Papers  

The following guidelines apply to research papers in the program unless students are 

otherwise instructed by the professor. Each formatting element is described in detail, and a 

sample paper is provided as a visual aid in Appendix A.  

2.2.1 Fonts  

Research papers are written in 12 point Times New Roman font or another standard serif 

or sans-serif fonts like Cambria, Calibri, or Arial. Scripts and decorative fonts are not appropriate 

for research papers. The same font should be used throughout the entire paper for both the 

headings and the body of the paper.  

2.2.2 Spacing  

Lines in the body of the research papers are double-spaced. Block quotations are single-

spaced. The spacing requirement does not apply to special elements like tables and charts. For 

spacing between sentences, enter only one bar space (not two) following the closing punctuation 

of one sentence and the first word of the next sentence.   
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2.2.3 Margins and Indents  

Research papers should have 1” margins all around. This is the default setting for 

margins in Word. Following the title page, the first page of the paper should have a dropped top 

margin of 2”. This margin is preset for you in the WRS Research Paper Template. The standard 

heading for this page includes a repeat of the title of the paper in all caps followed by the word 

“Introduction” on the next line. After the heading, the body of the paper should be indented a ½” 

to begin regular paragraphs.  

If the paper is written with chapter style entries or sections, the first page of subsequent 

entries should also have the 2” top margin. Likewise, the bibliography and any appendices you 

include should have a 2” top margin. All other pages should have a 1” top margin.5  

2.2.4 Title Page  

Research papers should include a title page formatted as follows.  

• Center the name “Western Reformed Seminary” approximately 2” from the top of the page.  

• Following the title, enter two to three line spaces and insert a centered, straight line of 18 bar 

spaces if using the underscore key or 1 ½” if using a line from Shapes in the Insert tab.  

• Following the line, center the title of the paper in all capital letters. Long titles should be 

written in inverted pyramid style over double-spaced lines. The title should be no more than 

17 words, spaced over no more than three lines.  

• Following the title, enter two to three line spaces and insert another straight line of 18 bar 

spaces or a 1 ½” line.  

• Below this line, enter two to three more line spaces and write a presentation note that names 

the class and professor for whom the paper is written. A standard presentation note reads as 

follows:  

A Paper Presented to Dr. Battle 

In Partial Fulfillment 

Of the Requirements of the Course 

912 Biblical Interpretation 

 
5 Learn how to set the margin for a specific page here: 

http://wordfaqs.ssbarnhill.com/DifferentMargins.htm or here: https://www.youtube.com/watch?v=oJG5vOYdytM.  

http://wordfaqs.ssbarnhill.com/DifferentMargins.htm
https://www.youtube.com/watch?v=oJG5vOYdytM
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• Following the presentation line, enter two to three more line spaces and insert a third straight 

line of 18 bar spaces or a 1 ½ ” line.  

• Following this line, enter at least two line spaces and insert “By” followed by your name on 

the next line. Enter the month and year on a third line.  

• Please note that the exact line spacing of the title page will depend on how long your title is. 

All the text on the page should be centered vertically and spaced generously in each 

horizontal section for a visually appealing title page. See Appendix A for a visual example of 

the title page.  

2.2.5 Page Numbers  

The title page counts as the first page, but it should not be numbered. Any other front 

matter, such as a table of contents, should be numbered with lower case Roman numerals 

centered at the bottom of the page. Therefore, the first numbered page following the title page is 

page ii.  

The first page of the body of the paper should be numbered with Arabic numerals. The 

first number of the body of the paper should be centered at the bottom of the first page. For the 

remainder of the paper, place the number at the top right corner of the page.  

2.2.6 Outline Levels  

Most research papers will require multiple heading levels. Just like every “A” in an 

outline must have a “B” and every “1” must have a “2,” each sublevel heading of a paper must 

have at least one parallel heading at the same level. The following instructions for heading styles 

match the suggested guidelines in the 2015 revision of the “Student Supplement for The SBL 

Handbook of Style, Second Edition.”  

• At the top of the first page of the body of the paper, at the 2” margin drop, repeat the title of 

the paper, centered and in all capital letters in your chosen 12 point font. If the title flows 

over more than one line, the lines should be single-spaced. Return to double-spacing 

following the title and add “Introduction,” capitalizing just the first letter of the word.  

• First-level subheadings are centered and entered in bold type in headline style.  

• Second-level subheadings are also centered and entered in headline style, but they are not in 

bold type.  
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• Third-level subheadings are set at the left margin, not indented, written in headline style, and 

entered in bold, italicized text.  

• Fourth-level subheadings are also set at the left margin and not indented. They are written in 

headline style but not in bold or italicized text.  

• Please note that not all papers will require all four levels of subheadings.  

• See the Sample Paper in Appendix A for visual examples of the headings.  

2.2.7 Widows and Orphans  

A widow is a single line of text which is “widowed,” or left alone, at the top of a page. 

This is often the closing line of a paragraph. If this occurs, the preceding line from the previous 

page should be moved to the following page so that at least two lines of text appear at the top of 

the page, rather than one lonely line of text.  

An orphan is a single line of text, often the first line of a paragraph, which is alone at the 

bottom of a page. If this occurs, the single line of text should be moved to the following page. 

The principle of these rules is that no single line should open or close a page.  

In Word, enable the “Widow/Orphan control” feature to automatically eliminate widows 

and orphans. To enable this setting, in the Home tab, select the small arrow in the bottom right 

corner of the Paragraph section. In the pop-up, go to “Line and Page Breaks” and select 

“Widow/Orphan control.” Set this as the default and select “Ok.”  

2.2.8 Block Quotations  

If a quote is longer than five lines, it belongs in an indented block of text. After 

introducing the material, enter a line space and indent a ½”. Do not add quotation marks at the 

beginning or end of the quoted material. The footnote number for the source should follow the 

final punctuation of the quotation as usual. Single-space and left justify the entire block of text, 

including the first line. After the quoted material, return to the double-spaced, normal text for the 

rest of the paragraph.  

2.2.9 Hebrew, Aramaic, Greek, and Other Ancient Languages  

Students in Seminary will frequently use the biblical languages of Hebrew, Aramaic, and 

Greek in research papers. Students should use the SBL Hebrew and Greek fonts to depict words 

instead of using transliteration characters.  
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Students can download the free SBL fonts for Hebrew and Greek from the SBL website.6 

Be sure to download both the font and the keyboard, along with the instruction manual for each 

font and keyboard.  

For optimal readability, set the Hebrew font to size 16. The larger Hebrew font will alter 

the line spacing of a Word document. To correct this manually, select the line spacing icon in the 

Paragraph tab. Then select Line Spacing Options. Find “Spacing” toward the lower third of the 

pop-up box. Go to “Line Spacing” and open the dropbox. Select “Exactly.” Then enter 24 in the 

“At” category beside “Line Spacing.” This will format your text to be exactly double-spaced 

despite the larger Hebrew font. Since the Greek font is readable at size 12, no special settings are 

necessary to accommodate the Greek font. Students may use other ancient languages in their 

papers as well, such as Akkadian or Ugaritic. For other ancient languages, please refer to 

“Transliterating and Transcribing Ancient Texts,” which is Chapter 5 in the SBL handbook. 

Please also seek clarification from the professor on any requirements for specific languages in 

your papers.  

2.2.10 Tables and Figures  

Tables  

If you include tabular data in your research paper, use the Table feature in Microsoft 

Word to design your table. Use the same font you have selected for the rest of your paper. The 

font size for the data table may be less than size 12, but it should not be smaller than size 10. 

Data tables should have clearly labeled headings to indicate the categories of data in each part of 

the table.  

Whenever possible, design tables that can fit on one page. If the table does not fit on one 

page, there are two options. The first option is to summarize the data in writing in the body of the 

paper and display the data table in an appendix. If you choose this option, refer to the appropriate 

appendix in your summary of the data. The second option is to run the table over onto the next 

page. If you choose this option, repeat the title at the top of the data table on the new page and 

add the word “continued” in parenthesis. Then repeat the column labels at the top of the data 

table on the second page as well so that the reader does not have to return to the previous page to 

 
6 Get free Hebrew and Greek fonts from the SBL website: https://www.sbl-

site.org/educational/biblicalfonts.aspx.  

https://www.sbl-site.org/educational/biblicalfonts.aspx
https://www.sbl-site.org/educational/biblicalfonts.aspx
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recall what is in each column. If data in your table is from another source or the table itself is 

from another source, proper credit must be given to the original source. See section 3.77 in CMS 

for information on proper source citation for tables. Label and number your tables using the 

“Insert Caption” feature in the References tab in Microsoft Word. For more information on 

formatting data tables, please refer to sections 3.47-3.88 in CMS.  

Figures  

On occasion, students may decide to use a graphic or figure to present information in a 

paper. Figures should be clear and easy to understand. Create your figures using the design 

feature available in the Insert tab in Microsoft Word. If you duplicate or adapt a figure originally 

designed by someone else, citation and copyright rules apply. See section 3.29-3.37 in CMS for 

more information on how to properly cite figures. Label and number your figures using the 

“Insert Caption” feature in the References tab in Microsoft Word.  

2.2.11 Footnotes  

To cite secondary sources, use footnotes rather than in-text citations or endnotes unless 

otherwise directed by the professor for a particular assignment. Indent a ½” for the start of each 

footnote. Footnotes are written in a 10 point font, and entries are single-spaced. One line space 

should separate each subsequent entry.  

For details on how to format footnotes for various types of sources, follow the style 

guidelines in the SBL handbook. If there is no information about how to cite a particular type of 

resource in the SBL handbook, consult CMS for more information.  

2.2.12 Bibliography  

In addition to the footnotes, research papers must include a bibliography. The 

bibliography should be formatted as follows.  

• The title “BIBLIOGRAPHY” is centered, dropped 2”, and written in all caps.  

• Entries are left-justified on the first line with a tab indent of a ½” for the remaining lines of 

the entry.  

• Entries are single-spaced with one blank line between each entry.  

• All bibliography notes should be written as described in the SBL handbook. For source types 

that are not included in SBL, please refer to CMS.  
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Students may enter the bibliography manually or use the Chicago Style bibliography tool 

in the References tab in Microsoft Word to record sources and enter the bibliography. After the 

entire bibliography is entered, changes can be made manually if the program produces any gaps 

or errors in formatting. However, students should be aware that updating the bibliography with 

added sources will erase any manual changes and revert the entry to the original form. Therefore, 

any corrections should be made after all the entries have been added. Students may use other 

citation formatting tools if they wish to do so. Whatever tool a student chooses to use, the student 

is ultimately responsible to make sure the bibliography matches the specific SBL/CMS 

guidelines for the various types of entries.  
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3. The Thesis  

3.1 Introduction to the Thesis  

The guidelines in this manual provide a general structure for students to follow as they 

pursue a specific topic. Based on the feedback of their professor, students may want or need to 

make additions or adjustments to this basic design. Therefore, students should use this guide with 

the understanding that the final structure of their Thesis may vary somewhat from this general 

approach.  

3.2 Snapshot of the Thesis Structure  

There are five main divisions in the biblical/theological studies Thesis:  

1. Front Matter  

2. Introductory Chapter  

3. Content Chapter(s)  

4. Conclusion 

5. Back Matter 

In the Master of Biblical Studies and Master of Theological Studies programs, the first 

chapter of the Thesis presents a variety of introductory matters. Most Theses in the field of 

biblical/theological studies will include multiple content chapters following the introduction. The 

length and number of the content chapters will be based on the details of the topic and will vary 

considerably from student to student. The final chapter provides the conclusion of the study. The 

typical biblical/theological studies Thesis will be five to ten chapters long. The final chapter may 

be followed by some appendices, and the last section of the Thesis will be the bibliography.  

3.3 Overview & Composition of the Thesis Proposal  

The Thesis Proposal is a document in which the student proposes the topic and research 

design of the thesis study. The Thesis Proposal describes the research question, outlines a 

proposed approach to the Thesis, and includes a proposed bibliography based on the reading of 

the precedent literature. Because the Proposal describes future research, future tense should be 

used in describing the research design.  
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The student works with the professor advisor in the process of writing the Proposal, 

revising it as needed according to the feedback provided by the advisor. Once the Proposal is 

completed, the student moves on to writing the first two chapters of the Thesis.  

The Proposal is comprised of the following sections:  

1. A description of the topic  

2. A detailed outline of the Thesis  

3. A proposed bibliography. 

Further details on the content of each section are provided below.  

3.3.1 The First Section of the Proposal  

In the first section of the Proposal, students create an abstract or precis (pray-see) which 

describes a research question that has not yet been addressed in the worldwide body of literature. 

A gap in the existing literature on a given topic must be demonstrated to confirm the need for 

more study in that specific area and to justify the study as genuine original research. With a 

confirmed gap in the literature, the student proposes a specific research question for the topic and 

a strategy for conducting the research. The goal is for the student to write a Thesis that will fill 

an existing gap and therefore make a significant contribution to the body of literature in the field 

of biblical/theological studies.  

In addition to describing the literature gap, research question, and research strategy, the 

abstract should include a research purpose or thesis statement, and a brief discussion of the 

delimitations of the study. Depending on the nature of the topic, a discussion of technical 

terminology may also be included. The first section of the proposal should also include a 

potential Thesis title (15 to 17 words maximum). Students will consult with the professor about 

whether any other components are needed for this section based on their specific topics.  

3.3.2 The Second Section of the Proposal  

In the second section of the proposal, the student provides a detailed outline of what will 

be included in each chapter of the Thesis. The general components of a typical Thesis are listed 

above. Students should refer to this as a basic guide for the structure of their Thesis, consulting 

with the professor as needed for more specific guidance about how to design the outline for their 

particular topic.  



 

 

12 

 

3.3.3 The Third Section of the Proposal  

The third section is the proposed bibliography. The proposed bibliography will include 

all resources already identified pertinent to the area of study, which the student intends to utilize 

during the research. The proposed bibliography should be formatted according to bibliography 

standards as described in 2.2.12 Bibliography.  

3.3.4 The Length of the Proposal  

The length of the Thesis Proposal will vary from thesis to thesis. The description of the 

topic and problem will be a minimum of one page. A typical outline will also be one page. The 

outline should be detailed enough to demonstrate that the student has an appropriate plan for 

each chapter of the study. The proposed bibliography should include a minimum of twenty of the 

most key sources on the topic. The proposal does not need to be lengthy, but it must provide 

enough detail to establish the validity of the research question, confirm the need for the study, 

and demonstrate the feasibility of the research strategy.  

3.4 General Formatting Guidelines for the Thesis  

The following section will address the general formatting guidelines for the Thesis. Many 

of the formatting guidelines match those given for research papers, but some details are different, 

so please read carefully.  

3.4.1 Fonts and Spacing  

The font and spacing guidelines are the same for Theses as they are for research papers, 

with one exception, which is that the Times New Roman font is required. The guidelines are 

reviewed below.  

• Use the Times New Roman font in size 12.  

• Use font size 10 for footnotes.  

• Font size may be reduced for tables, but it should not be less than size 10.  

• Double-space the text in the body of the work.  

• Single-space footnotes and block quotations.  

• Enter only one bar space to separate one sentence from the next.  
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3.4.2 Margins, Indents, and Block Quotations  

Thesis margins are different than research paper margins. This is to provide extra space 

on the left side to accommodate the binding of the hard copies of the Thesis.  

• Set the left margin of the Thesis at 1 ½”.  

• The top, right, and bottom of the page has the usual 1” margin.  

• Paragraphs in the body of the text are indented a ½”.  

• The abstract, acknowledgments, dedication, the first page of each chapter, appendices, and 

bibliography all have a 2” dropped top margin.  

• All other pages begin at the 1” top margin. This includes the table of contents, abbreviations 

list, glossary, list of tables, and list of figures.  

• Block quotations are formatted the same way they are in research papers. Indent the block a 

½” and left justify the entire block. The text should be single-spaced. Do not enclose the 

block in quotation marks. Enter the footnote number following the closing punctuation of the 

quotation.  

3.4.3 Widows and Orphans  

Use the Widow/Orphan control feature in Word to eliminate widows and orphans, just as 

you would do in a research paper.  

3.4.4 Page Numbers  

• Thesis page numbers are formatted the same way as the research papers.  

• Use Roman numerals in the front matter, centered at the bottom of the page.  

• Use Arabic numerals for the body, centered at the bottom of the first page of each chapter 

and placed in the top right corner for subsequent pages.  

• See further details on pagination in the section about the front matter.  

3.4.5 Outline Levels  

The outline levels for the Thesis are the same as the research paper.  

• Chapter titles are centered in bold text at the 2” dropped margin point.  

• First-level subheadings are centered and entered in bold type in headline style.  

• Second-level subheadings are also centered and entered in headline style, but they are not in 

bold type.  
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• Third-level subheadings are set at the left margin, not indented, written in headline style, and 

entered in bold, italicized text.  

• Fourth-level subheadings are also set at the left margin and not indented. They are written in 

headline style but not in bold or italicized text.  

• Please note that not all Theses will require four levels of subheadings.  

• See the section on Content Chapters for the formatting of the first page of each chapter.  

3.4.6 Hebrew, Aramaic, Greek, and Other Ancient Languages  

The guidelines for the original biblical languages and other ancient languages are the 

same for Theses as they are for research papers. See section 2.2.9.  

3.4.7 Tables and Figures  

The general guidelines for designing and labeling Tables and Figures are the same for 

Theses as they are for research papers (section 2.2.10). However, further information on 

formatting the List of Tables and List of Figures for the front matter of the Thesis is included in 

sections 3.5.10 and 3.5.11.  

3.4.8 Footnotes  

Footnotes are used for the Thesis just as they are for research papers.  

• Indent ½” for the start of each footnote.  

• Footnotes are written in a 10 point font, and entries are single-spaced.  

• One line space should separate each subsequent entry.  

For details on how to format footnotes for various types of sources, follow the style 

guidelines in the SBL handbook. If there is no information about how to cite a particular type of 

resource in the SBL handbook, consult CMS for more information.  

3.5 Specific Formatting Guidelines for the Thesis Front Matter  

The front matter includes a variety of information to orient the reader to the Thesis. The 

following section describes the formatting details. See Appendix B for visual aid.  

3.5.1 The Title Page  

The title page includes the title of your work, your seminary, your name, and the date of 

completion. Format it according to the guidelines below.  
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• Center the title in all caps. Use the inverted pyramid style if the title is long.  

• Enter three line spaces after the title and create a dividing line of 18 bar spaces either by 

using the underscore key on your keyboard or by inserting a 1 ½” line from the “Shapes” 

feature in the Insert tab.  

• Enter the purpose phrasing over three double-spaced, centered lines:  

In Partial Fulfillment 

Of the Requirements for the Degree 

Master of Biblical Studies 

• Enter another centered, 18-space or 1 ½” line, three line spaces after the purpose.  

• Enter “By” on the next line followed by your name on the line after that.  

• On the next line, enter the month and year that the final version of your Thesis was approved.  

• The title page is required, but it is not “counted,” meaning that it is not included in the total 

number of pages of your Thesis. It is also not numbered.  

3.5.2 The Copyright Page  

The copyright page confirms that you are the owner of your work and that you are 

allowing Western Reformed Seminary to use it. The text of the copyright page is formatted as 

follows, with your name, the Thesis title, and the year of completion inserted in the appropriate 

places:  

Last Name, First Name Middle Initial. Year. Thesis Title in Headline Style Here. Master’s 

Thesis, Western Reformed Seminary.  

Copyright © Year. First Name Middle Initial. Last Name.  

All Rights Reserved. Western Reformed Seminary has permission to reproduce and disseminate 

this document in any form by any means for purposes chosen by Western Reformed Seminary, 

including without limitation, preservation, or instruction.  

The copyright page is required but not counted or numbered. The text should be placed 

near the bottom of the page. See the Thesis Template for a visual of the placement.  
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3.5.3 The Abstract  

The abstract is a brief description of your Thesis. It should capture the main argument 

and explain the outcome of the research in two to five clear, concise paragraphs. The abstract 

may be longer than one page, depending on the level of detail necessary to describe your topic. 

• The title for this page is centered and dropped 2” like a chapter heading. 

• The body of the text is double-spaced and has the same 1 ½” left margin and 1” right margin 

as the body of the Thesis. 

• This page is required, counted, and numbered. As part of the front matter, it is numbered in 

Roman numerals. Because it is the second counted page but the first numbered page, it will 

be page ii. 

3.5.4 The Acknowledgements Page 

On this page, students acknowledge significant people who provided support, input, or 

assistance at any point in the student’s academic journey and in the Thesis writing process. 

Students may wish to thank mentors, professors, advisors, readers, editors, or any other academic 

staff or faculty member who helped in some way. This is also a place to thank friends and family 

members for their support.  

• The title for this page is centered, dropped 2”, and set at the same margins previously 

indicated.  

• The acknowledgments page is written in double-spaced paragraph style.  

• The page is required, counted, and numbered with a Roman numeral. 

3.5.5 The Dedication Page 

Students may opt to dedicate the finished work to a specific person or people. The work 

is often dedicated to family members, but it may be dedicated to anyone the student chooses.  

• The title for this page is centered, dropped 2”, and set at the same margins previously 

indicated.  

• The dedication page is written in double-spaced paragraph style.  

• The page is optional. If used, it is counted and numbered with a Roman numeral. 
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3.5.6 The Table of Contents 

 The table of contents shows the reader the entire Thesis at a glance. It begins with the 

front matter, shows the divisions of the chapters through the third-level subheadings, and ends 

with the back matter.  

• The table should provide page numbers but may also include an option for hyperlinks for 

PDF or other online versions of the work.  

• The title for this page is centered with a top margin of 1”.  

• The Styles feature in Microsoft Word allows for headings to be automatically formatted and 

updated in the table of contents.  

• The table of contents is required, counted, and numbered.  

3.5.7 The List of Abbreviations 

Most biblical/theological studies Theses will have repeated references to proper nouns 

that are designated by specific abbreviations. These include versions of the Bible, ancient works, 

journal titles, and other abbreviations related to the field. To assist readers as they navigate your 

Thesis, you will provide a list of these abbreviations in the front matter. Guidelines for the 

abbreviations are below.  

• Do not include abbreviations for the books of the English Bible in this section. It is assumed 

that readers of biblical/theological studies Theses are familiar with the standard abbreviations 

for the biblical texts.  

• The first time you use a term that will be abbreviated, write it out in full and include the 

abbreviation beside it in parenthesis. After the introductory use, switch to the abbreviation 

for the remainder of the work.  

• Any abbreviation you use more than once should be included in the list of abbreviations, 

except for the names of the books of the English Bible.  

• Do include abbreviations for English versions of the Bible, such as NAS or NIV.  

• Do include abbreviations of other ancient translations of the Bible, such as the Septuagint, 

and other ancient works, such as the books of the Apocrypha or Pseudepigrapha.  

• Include abbreviations for the journal titles referenced in your work.  

• Include grammar abbreviations if you use them in your work.  
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• Depending on your subject matter, you may need to include other types of abbreviations as 

well.  

• This title for this page is centered with a top margin of 1”.  

• List the abbreviations on the left with no indentation.  

• Follow the abbreviation with a 1” indent and insert a full writing of the term that is 

designated by the abbreviation.  

This page is required unless the requirement is waived by the advisor. The page is 

counted and numbered. 

3.5.8 The Glossary of Special Terms 

 Some Theses will include terminology that is not familiar to all readers. If the Thesis 

includes technical or specialized terms that may not be recognized by the majority of readers, the 

front matter should include a glossary of terms. Students may consult with their advisors about 

whether or not to include a glossary.  

• This title for this page is centered with a top margin of 1”.  

• List the terms on the left side with no indentation.  

• Following each term, enter an em dash and the definition of the term.  

This page is optional. If used, it is counted and numbered. 

3.5.9 The List of Tables 

Most biblical/theological studies Theses will include tabular data. Throughout the Thesis, 

data tables should be numbered and labeled using “Insert Caption” in Microsoft Word to 

automatically generate information for the list of tables in the front matter. Students who are 

unfamiliar with the Caption and Table features may view a Word tutorial to learn how to label 

their data tables and generate the front matter list.7  

• Tables may be identified by simple sequential numbering (Table 1, Table 2, Table 3, etc.), or 

they may be identified by the chapter plus the number (Table 1.1, Table 2.1, Table 3.1, etc.). 

 
7 A Word Tutorial on how to use the Caption and Table features to generate a List of Tables in the Table of 

Contents: https://support.microsoft.com/en-us/office/insert-a-table-of-figures-c5ea59c5-487c-4fb2-bd48-

e34dd57f0ec1.  

https://support.microsoft.com/en-us/office/insert-a-table-of-figures-c5ea59c5-487c-4fb2-bd48-e34dd57f0ec1
https://support.microsoft.com/en-us/office/insert-a-table-of-figures-c5ea59c5-487c-4fb2-bd48-e34dd57f0ec1
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Either system is appropriate for a Thesis with a small number of tables. The chapter plus 

number system is best for a Thesis with many tables.  

• Labels for tabular data should be clear and concise.  

• Center the title for this page at the 1” margin.  

• The table list is automatically generated by Word and is already set up in the Thesis 

Template. With proper Caption formatting, the list can be updated periodically as students 

add tabular data to their Theses.  

This page is required if tabular data is used in the Thesis. If the page is used, it is counted 

and numbered. 

3.5.10 The List of Figures  

Many biblical/theological studies  Theses will include figures. Figures are graphs, 

pictures, diagrams, or other visual aids that do not contain tabular data. Figures should also be 

numbered and labeled using the Caption feature in Word.  

• Like tables, figures may be identified with the simple sequential numbering system (Figure 1, 

Figure 2, Figure 3, etc.) or the chapter plus number system (Figure 1.1, Figure 2.1, Figure 

3.1, etc.). As with tables, either system is appropriate for Theses with a small number of 

figures. For Theses with a large number of figures, the chapter plus number system is most 

appropriate.  

• The title for this page is centered with a top margin of 1”.  

• The figure list is automatically generated by Word and is already set up in the Thesis 

Template. With proper Caption formatting, the list can be updated periodically as students 

add tabular data to their Theses.  

• This page is required if figures are used in the Thesis. If the page is used, it is counted and 

numbered. 

3.6 The Composition of the Thesis  

3.6.1 The Composition of Chapter 1: The Introduction  

The first chapter in a biblical/theological studies Thesis is the introduction. The purpose 

of this chapter is to introduce all the basic elements of the study so that the reader has a solid 

understanding of the need for the study, the research question, the purpose of the study, and the 

strategy for the research. The study may be introduced using the categories below. Each category 
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listed below is accompanied by a question or two to help guide your thoughts about how to 

describe these issues to your reader.  

• Overview of the general topic: What is the subject matter? What are you writing about?  

• A brief discussion of the literature gap: In general, what have previous authors highlighted in 

discussions of this topic?  

• Presentation of the specific research question: Having considered the general subject matter 

and broadly described previous discussions of it, what is your new, specific question about 

the topic? What are you asking or seeking to discover that has never been asked in precisely 

this same way before?  

• Description of the research purpose: What is the purpose of investigating this issue? What 

outcome do you expect or hope to have?  

• Description of the research strategy (methodology) of the study: How will this research 

question be answered? What specific research processes will you use to establish the answer 

to the question?  

• Explanation of research assumptions: What are the fundamental building blocks that underlie 

the research? What beliefs, facts, doctrines, suppositions, or principles are guiding your 

research process?  

• Discussion of terminology, if applicable: What terms are you using in particular ways that 

the reader needs to know upfront to properly understand your work? What clarification do 

they need to understand how and why you are using the term this way?  

• Discussion of the delimitations of the study: What factors will you exclude to narrow the 

focus of your study?  

Use this list as a starting point as you plan the approach to your introductory chapter. 

Keep in mind that some introductions may include more or less information than this, depending 

on the details of the topic. Your professor will help you think through the best way to introduce 

your subject matter.  

3.6.2 The Composition of the Content Chapters 

The purpose of the content chapters is to present the research. Here the student describes 

the data and findings and discusses the analysis of the findings. The length, content, and number 
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of these chapters will vary according to the Thesis topic. Students will work with their advisors 

on how to present their content.  

3.6.3 The Composition of the Concluding Chapter 

The final chapter summarizes the entire study, beginning with a restatement of the 

research question and purpose and closing with suggestions for further research. Additional 

components of the final chapter are listed below.  

• Restatement of the research question and purpose: This section reminds the reader of the 

original aim of your Thesis. The research questions and purpose may be restated essentially 

verbatim from the first chapter.  

• Presentation of the final conclusions of the study: Describe the ultimate findings of the study 

in detail. What new facts were established by this research? What do these new findings tell 

us that we did not know before?  

• Evaluation of the research design: How well did this study meet the purpose for which it was 

designed? Were the goals of the study achieved, and if so, how were they achieved?  

• Discussion of the research implications: What do the findings suggest about the general 

subject matter which first inspired the research question for this study? How does this 

research contribute to the field of biblical/theological studies?  

• Discussion of the research applications: How can this new information or deeper 

understanding be applied in the other areas of biblical/theological studies which are related to 

this subject?  

• Suggestions for further research: What else can be learned about this topic? What related 

questions arose in the process of this study that remain to be answered?  

3.6.4 The Composition and Formatting of the Back Matter  

The back matter of the biblical/theological studies Thesis consists of the appendices and 

the bibliography.  

Appendices  

• Each appendix must have a title and a letter.  

• The title is centered at the 2” dropped top margin.  
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• Appendices are numbered like chapters. Center the number of the first page at the bottom of 

the page. Subsequent page numbers are in the top right corner.  

• Page numbers run consecutively from the body of the Thesis.  

Bibliography  

• The title is centered at the 2” dropped top margin.  

• Entries begin at the 1 ½” left margin and are indented a ½” on subsequent lines.  

• Entries are separated by one line space.  

• The content of the entries is formatted according to SBL/CMS guidelines.  

• Students may use the References feature in Word or another reference program to keep track 

of their sources, but the student is ultimately responsible for the accuracy of both the 

information in the entry and the formatting of the entry.  
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4. Research Writing Guidelines  

The purpose of this section is to introduce you to the writing etiquette for our seminary. 

These guidelines apply to research papers and the Thesis. Other types of writing in the program 

may require less formality. Check with your professors about specific requirements for other 

types of assignments.  

4.1 Effective Research Writing  

An effective research writer presents the facts, analysis, and conclusions of a robust study 

in a convincing way. Grammar mistakes, confusing sentences, and failure to observe standard 

writing conventions can distract your reader from the content of your paper. The purpose of the 

following guidelines is to help you write clearly and to alert you to the norms of the field so that 

your reader can fully focus on the merits of your argument.  

4.1.1 Simply Do  

• Write clear sentences in plain language.8 For a helpful review of general grammar and syntax 

issues, see Ch. 5 “Grammar and Usage” in CMS or Ch. 11 “Revising Sentences” in Turabian.  

• Get to the point. Frequently frontload your sentences with the subject matter and an 

appropriate verb rather than with too many introductory clauses.9  

• Use the Oxford comma to give the greatest degree of clarity to your reader. For more 

information on commas and other punctuation issues, see Ch. 6 “Punctuation” in CMS or Ch. 

21 “Punctuation” in Turabian.  

• Vary the length and style of your sentences to keep the reader engaged.10  

• Use strong verbs in the active voice.11  

 
8 How to write in plain language: https://zapier.com/blog/plain-language/.  

9 How to handle introductory clauses: http://www.practicalmakesperfect.com/2019/01/21/too-many-

introductory-phrases-spoil-the-essay/.  

10 How to vary the length and style of your sentences: 

https://academicguides.waldenu.edu/writingcenter/scholarlyvoice/sentencestructure.  

11 Use strong verbs: https://www.enchantingmarketing.com/strong-verbs/; Use the active voice: 

https://www.grammarly.com/blog/active-vs-passive-voice/.  

https://zapier.com/blog/plain-language/
http://www.practicalmakesperfect.com/2019/01/21/too-many-introductory-phrases-spoil-the-essay/
http://www.practicalmakesperfect.com/2019/01/21/too-many-introductory-phrases-spoil-the-essay/
https://academicguides.waldenu.edu/writingcenter/scholarlyvoice/sentencestructure
https://www.enchantingmarketing.com/strong-verbs/
https://www.grammarly.com/blog/active-vs-passive-voice/
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• Avoid writing in the passive voice, but do not avoid it slavishly. The passive voice is 

sometimes the simplest way to make a clear statement.12  

• Write in the third person voice unless the professor or your advisor has permitted you to use 

the first-person voice for a particular assignment.13 

• Make sure your subject and verb agree with one another.14 This becomes more difficult in 

longer sentences with multiple clauses. In a sentence with clauses between the subject and 

the verb, skip over the clauses and read only the subject and the verb to make sure they agree. 

•  Choose one or two powerful adjectives instead of three or four.15  

• Vary your word choices. Use thesaurus.com16 or the thesaurus in the Review tab in Word for 

alternate word suggestions.  

• Overall, avoid using contractions in your paper, but every once in a while, it’s ok.17  

• Use the Spelling and Grammar feature in the Review tab to check your work.  

• Right-click on the red, blue, or green error indicators under words in your document to find 

out why they are flagged.18 Make corrections if necessary.  

 
12 When to use the passive voice: https://www.grammarly.com/blog/passive-

voice/#:~:text=The%20passive%20voice%20is%20your,subject%20is%20distracting%20or%20irrelevant.  

13 Use the third person voice: http://blogs.ubc.ca/writingcentre/files/2013/01/Tutor-project-Avoid-First-

Person-POV.pdf.  

14 Subject and verb agreement: http://guidetogrammar.org/grammar/sv_agr.htm.  

15 Choose powerful adjectives: https://simplewriting.org/kill-your-adjectives/; Use fewer adjectives: 

https://www.insidehighered.com/news/2013/08/29/study-finds-too-many-adjectives-and-adverbs-detract-academic-

writing.  

16 Use an online thesaurus: https://www.thesaurus.com/.  

17 When to use contractions: https://www.vappingo.com/word-blog/when-is-it-okay-to-use-contractions-in-

formal-writing/.  

18 Error indicators in Word: https://www.techrepublic.com/blog/microsoft-office/train-users-to-appreciate-

words-annoying-wavy-blue-

lines/#:~:text=In%20fact%2C%20one%20of%20Word's,spots%20(possibly)%20misspelled%20words.&text=As%2

0you%20type%2C%20Word%20displays,indicates%20a%20possible%20grammatical%20error.  

https://www.grammarly.com/blog/passive-voice/#:~:text=The%20passive%20voice%20is%20your,subject%20is%20distracting%20or%20irrelevant
https://www.grammarly.com/blog/passive-voice/#:~:text=The%20passive%20voice%20is%20your,subject%20is%20distracting%20or%20irrelevant
http://blogs.ubc.ca/writingcentre/files/2013/01/Tutor-project-Avoid-First-Person-POV.pdf
http://blogs.ubc.ca/writingcentre/files/2013/01/Tutor-project-Avoid-First-Person-POV.pdf
http://guidetogrammar.org/grammar/sv_agr.htm
https://simplewriting.org/kill-your-adjectives/
https://www.insidehighered.com/news/2013/08/29/study-finds-too-many-adjectives-and-adverbs-detract-academic-writing
https://www.insidehighered.com/news/2013/08/29/study-finds-too-many-adjectives-and-adverbs-detract-academic-writing
https://www.thesaurus.com/
https://www.vappingo.com/word-blog/when-is-it-okay-to-use-contractions-in-formal-writing/
https://www.vappingo.com/word-blog/when-is-it-okay-to-use-contractions-in-formal-writing/
https://www.techrepublic.com/blog/microsoft-office/train-users-to-appreciate-words-annoying-wavy-blue-lines/#:~:text=In%20fact%2C%20one%20of%20Word's,spots%20(possibly)%20misspelled%20words.&text=As%20you%20type%2C%20Word%20displays,indicates%20a%20possible%20grammatical%20error
https://www.techrepublic.com/blog/microsoft-office/train-users-to-appreciate-words-annoying-wavy-blue-lines/#:~:text=In%20fact%2C%20one%20of%20Word's,spots%20(possibly)%20misspelled%20words.&text=As%20you%20type%2C%20Word%20displays,indicates%20a%20possible%20grammatical%20error
https://www.techrepublic.com/blog/microsoft-office/train-users-to-appreciate-words-annoying-wavy-blue-lines/#:~:text=In%20fact%2C%20one%20of%20Word's,spots%20(possibly)%20misspelled%20words.&text=As%20you%20type%2C%20Word%20displays,indicates%20a%20possible%20grammatical%20error
https://www.techrepublic.com/blog/microsoft-office/train-users-to-appreciate-words-annoying-wavy-blue-lines/#:~:text=In%20fact%2C%20one%20of%20Word's,spots%20(possibly)%20misspelled%20words.&text=As%20you%20type%2C%20Word%20displays,indicates%20a%20possible%20grammatical%20error
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• When in doubt about proper usages, like when to use “it’s” instead of “its” or “who instead 

of “whom,” look up the rule in CMS (section 5.250) or a convenient online source like Paul 

Bryan’s “Common Errors in English Usage.”19  

• For a variety of grammar and usage questions, take advantage of other online resources like 

Grammar Girl20 and Purdue’s Online Writing Lab.21 Grammarly22 has good reviews, but 

please be aware that the free resource is limited.  

• Consult the SBL handbook to make sure you are following the proper conventions for 

numbers (section 4.2), capitalization (section 4.3.6), and abbreviations (Ch. 8).  

4.1.2 Simply Do Not  

• Use slang, colloquialisms, or clichés in research writing.23 For more tips on words to avoid, 

read this article.24   

• Use all caps or bold text for emphasis. Skilled writers use sentence structure and word 

choices for emphasis.25 Italics may be used on occasion, but it should be rare.  

• Use “e.g.” or “i.e.” in the body of the paper. Instead, write out “for example” for e.g. and 

“that is” or “in other words” for i.e. However, it is acceptable to use e.g. and i.e. in footnotes. 

For an amusing discussion on the issue, read this post.26  For a scholarly explanation, see 

CMS, section 10.42.  

 
19 Common errors in English: https://brians.wsu.edu/common-errors/.  

20 Grammar Girl: https://www.quickanddirtytips.com/grammar-girl.  

21 Purdue’s Online Writing Lab (OWL): https://owl.purdue.edu/.  

22 Grammarly: https://www.grammarly.com/.  

23 Slang, colloquialisms, and clichés: https://www.capstoneediting.com.au/blog/avoiding-colloquial-

language-in-academic-writing. 

24 More words to avoid: https://www.scribbr.com/academic-writing/taboo-words/.  

25 How to write with emphasis: https://www.writeexpress.com/emphasis.html.  

26 The use of e.g. and i.e.: https://thebettereditor.wordpress.com/2017/07/31/i-e-and-e-g-youre-not-writing-

in-latin-so-why-are-you-using-them/.  

https://brians.wsu.edu/common-errors/
https://www.quickanddirtytips.com/grammar-girl
https://owl.purdue.edu/
https://www.grammarly.com/
https://www.capstoneediting.com.au/blog/avoiding-colloquial-language-in-academic-writing
https://www.capstoneediting.com.au/blog/avoiding-colloquial-language-in-academic-writing
https://www.scribbr.com/academic-writing/taboo-words/
https://www.writeexpress.com/emphasis.html
https://thebettereditor.wordpress.com/2017/07/31/i-e-and-e-g-youre-not-writing-in-latin-so-why-are-you-using-them/
https://thebettereditor.wordpress.com/2017/07/31/i-e-and-e-g-youre-not-writing-in-latin-so-why-are-you-using-them/


 

 

26 

 

• Use “etc.” in the body of the paper. Instead, concretely describe or list all the information 

you want to provide on a given subject. If there is more information than you care to include 

in the body, add it in a footnote.  

4.1.3 It Is Actually Acceptable to… 

• Begin a sentence with a conjunction like “but” or “and.” For further guidance, see CMS, 

sections 5.203 and 5.204.  

• Split an infinitive. See CMS, sections 5.108 and 5.171.  

• End a sentence with a preposition when it’s the simplest way to get your point across. See 

CMS, section 5.180.  

For more tips on misconceptions about English, please also see Dryer’s English: An 

Utterly Correct Guide to Clarity and Style (New York: Random House, 2019) by Benjamin 

Dryer.  

4.2 Proofreading  

All writers make mistakes, no matter how talented they are. Therefore, students must 

proofread their papers before submitting them. However, simply rereading your paper is usually 

not enough to help you catch your mistakes. The problem is that our eyes tend to read what we 

believe we wrote rather than what is actually written. To proofread more effectively, try these 

methods.  

• Start writing early so you can finish your paper well ahead of the deadline. Then step away 

from your work for a day or two. After you have had a significant break from the paper, 

proofread it. The time spent working on other things will help you catch mistakes you missed 

when you were focusing closely on the paper for an extended period of time.  

• Read your paper out loud. As you read the paper out loud, your ears will catch errors that 

your eyes might miss.  

• Read the paper from the end to the beginning. Start with the last sentence of the last 

paragraph. Work your way back through each preceding sentence and paragraph to the 

beginning of the paper. Starting at the end disrupts your anticipation of what is coming next. 

That disruption can cause you to see things you might otherwise miss.  

• If you struggle with writing, ask a friend or family member to proofread it too.  
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• Make an appointment with your professor or the administration if you need extra help.  

4.3 Plagiarism 

At the graduate level of study, it is expected that students understand how to properly 

introduce and cite secondary sources. As a reminder, you must give credit to the original source 

any time you quote, summarize, or paraphrase other people’s words or ideas in your work. 

WRS’s summary statement on plagiarism is below.  

WRS students are required to know how to give proper credit to the academic works they 

reference in their own written projects. Failure to credit properly other works will make 

the student liable to WRS’s penalty for plagiarism: the assignment will be recorded as a 0 

and must be resubmitted with changes to reflect proper intellectual credit. Other 

disciplinary action may be taken as well.  

Students are responsible to familiarize themselves with WRS’s Plagiarism Policy and 

adhere to it. It is located in the Student Handbook. For a refresher on how to properly handle 

sources and avoid plagiarism, please see Ch. 25, “Quotations,” in the Turabian manual. 

Plagiarism.org27 is another helpful resource for students with questions about how to present 

material from secondary sources and avoid accidental plagiarism.  

 

 
27 Plagiarism.org: https://www.plagiarism.org/.  

https://www.plagiarism.org/
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Appendix A: The Research Paper Template  
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Appendix C: Links to External Sources  

P. 2 – “Student Supplement to The SBL Handbook, Second Edition,” updated 2015:  

https://www.sbl-site.org/assets/pdfs/pubs/SBLHSsupp2015-02.pdf   

P. 4 – Learn how to set the margin for a specific page here: 

http://wordfaqs.ssbarnhill.com/DifferentMargins.htm   

or here: https://www.youtube.com/watch?v=oJG5vOYdytM   

P. 7 – Get free Hebrew and Greek fonts from the SBL website: https://www.sbl-

site.org/educational/biblicalfonts.aspx   

P. 18 – A Word Tutorial on how to use the Caption and Table features to generate a List 

of Tables in the Table of Contents: https://support.microsoft.com/en-us/office/insert-a-table-of-

figures-c5ea59c5-487c-4fb2-bd48-e34dd57f0ec1   

P. 23 – How to write in plain language: https://zapier.com/blog/plain-language/   

P. 23 – How to handle introductory clauses: 

http://www.practicalmakesperfect.com/2019/01/21/too-many-introductory-phrases-spoil-the-

essay/   

P. 23 – How to vary the length and style of your sentences: 

https://academicguides.waldenu.edu/writingcenter/scholarlyvoice/sentencestructure   

P. 23 – Use strong verbs: https://www.enchantingmarketing.com/strong-verbs/   

P. 23 – Use the active voice: https://www.grammarly.com/blog/active-vs-passive-voice/  

P. 24 – When to use the passive voice: https://www.grammarly.com/blog/passive-

voice/#:~:text=The%20passive%20voice%20is%20your,subject%20is%20distracting%20or%20

irrelevant   

P. 24 – Use the third person voice: http://blogs.ubc.ca/writingcentre/files/2013/01/Tutor-

project-Avoid-First-Person-POV.pdf   

P. 24 – Subject and verb agreement: http://guidetogrammar.org/grammar/sv_agr.htm   

P. 24 – Choose powerful adjectives: https://simplewriting.org/kill-your-adjectives/   

P. 24 – Use fewer adjectives: https://www.insidehighered.com/news/2013/08/29/study-

finds-too-many-adjectives-and-adverbs-detract-academic-writing   

P. 24 – Use an online thesaurus: https://www.thesaurus.com/   

P. 24 – When to use contractions: https://www.vappingo.com/word-blog/when-is-it-okay-

to-use-contractions-in-formal-writing/   

https://www.sbl-site.org/assets/pdfs/pubs/SBLHSsupp2015-02.pdf
http://wordfaqs.ssbarnhill.com/DifferentMargins.htm
https://www.youtube.com/watch?v=oJG5vOYdytM
https://www.sbl-site.org/educational/biblicalfonts.aspx
https://www.sbl-site.org/educational/biblicalfonts.aspx
https://support.microsoft.com/en-us/office/insert-a-table-of-figures-c5ea59c5-487c-4fb2-bd48-e34dd57f0ec1
https://support.microsoft.com/en-us/office/insert-a-table-of-figures-c5ea59c5-487c-4fb2-bd48-e34dd57f0ec1
https://zapier.com/blog/plain-language/
http://www.practicalmakesperfect.com/2019/01/21/too-many-introductory-phrases-spoil-the-essay/
http://www.practicalmakesperfect.com/2019/01/21/too-many-introductory-phrases-spoil-the-essay/
https://academicguides.waldenu.edu/writingcenter/scholarlyvoice/sentencestructure
https://www.enchantingmarketing.com/strong-verbs/
https://www.grammarly.com/blog/active-vs-passive-voice/
https://www.grammarly.com/blog/passive-voice/#:~:text=The%20passive%20voice%20is%20your,subject%20is%20distracting%20or%20irrelevant
https://www.grammarly.com/blog/passive-voice/#:~:text=The%20passive%20voice%20is%20your,subject%20is%20distracting%20or%20irrelevant
https://www.grammarly.com/blog/passive-voice/#:~:text=The%20passive%20voice%20is%20your,subject%20is%20distracting%20or%20irrelevant
http://blogs.ubc.ca/writingcentre/files/2013/01/Tutor-project-Avoid-First-Person-POV.pdf
http://blogs.ubc.ca/writingcentre/files/2013/01/Tutor-project-Avoid-First-Person-POV.pdf
http://guidetogrammar.org/grammar/sv_agr.htm
https://simplewriting.org/kill-your-adjectives/
https://www.insidehighered.com/news/2013/08/29/study-finds-too-many-adjectives-and-adverbs-detract-academic-writing
https://www.insidehighered.com/news/2013/08/29/study-finds-too-many-adjectives-and-adverbs-detract-academic-writing
https://www.thesaurus.com/
https://www.vappingo.com/word-blog/when-is-it-okay-to-use-contractions-in-formal-writing/
https://www.vappingo.com/word-blog/when-is-it-okay-to-use-contractions-in-formal-writing/


 

 

52 

 

P. 24 – Error indicators in Word: https://www.techrepublic.com/blog/microsoft-

office/train-users-to-appreciate-words-annoying-wavy-blue-

lines/#:~:text=In%20fact%2C%20one%20of%20Word's,spots%20(possibly)%20misspelled%20

words.&text=As%20you%20type%2C%20Word%20displays,indicates%20a%20possible%20gr

ammatical%20error.   

P. 25 – Common errors in English: https://brians.wsu.edu/common-errors/    

P. 25 – Grammar Girl: https://www.quickanddirtytips.com/grammar-girl   

P. 25 – Purdue’s Online Writing Lab (OWL): https://owl.purdue.edu/   

P. 25 – Grammarly: https://www.grammarly.com/    

P. 25 – Slang, colloquialisms, and clichés: 

https://www.capstoneediting.com.au/blog/avoiding-colloquial-language-in-academic-writing   

P. 25 – More words to avoid: https://www.scribbr.com/academic-writing/taboo-words/   

P. 25 – How to write with emphasis: https://www.writeexpress.com/emphasis.html   

P. 25 – The use of e.g. and i.e.: https://thebettereditor.wordpress.com/2017/07/31/i-e-and-

e-g-youre-not-writing-in-latin-so-why-are-you-using-them/   

P. 27 – Plagiarism.org: https://www.plagiarism.org/  

 

https://www.techrepublic.com/blog/microsoft-office/train-users-to-appreciate-words-annoying-wavy-blue-lines/#:~:text=In%20fact%2C%20one%20of%20Word's,spots%20(possibly)%20misspelled%20words.&text=As%20you%20type%2C%20Word%20displays,indicates%20a%20possible%20grammatical%20error
https://www.techrepublic.com/blog/microsoft-office/train-users-to-appreciate-words-annoying-wavy-blue-lines/#:~:text=In%20fact%2C%20one%20of%20Word's,spots%20(possibly)%20misspelled%20words.&text=As%20you%20type%2C%20Word%20displays,indicates%20a%20possible%20grammatical%20error
https://www.techrepublic.com/blog/microsoft-office/train-users-to-appreciate-words-annoying-wavy-blue-lines/#:~:text=In%20fact%2C%20one%20of%20Word's,spots%20(possibly)%20misspelled%20words.&text=As%20you%20type%2C%20Word%20displays,indicates%20a%20possible%20grammatical%20error
https://www.techrepublic.com/blog/microsoft-office/train-users-to-appreciate-words-annoying-wavy-blue-lines/#:~:text=In%20fact%2C%20one%20of%20Word's,spots%20(possibly)%20misspelled%20words.&text=As%20you%20type%2C%20Word%20displays,indicates%20a%20possible%20grammatical%20error
https://www.techrepublic.com/blog/microsoft-office/train-users-to-appreciate-words-annoying-wavy-blue-lines/#:~:text=In%20fact%2C%20one%20of%20Word's,spots%20(possibly)%20misspelled%20words.&text=As%20you%20type%2C%20Word%20displays,indicates%20a%20possible%20grammatical%20error
https://brians.wsu.edu/common-errors/
https://www.quickanddirtytips.com/grammar-girl
https://owl.purdue.edu/
https://www.grammarly.com/
https://www.capstoneediting.com.au/blog/avoiding-colloquial-language-in-academic-writing
https://www.scribbr.com/academic-writing/taboo-words/
https://www.writeexpress.com/emphasis.html
https://thebettereditor.wordpress.com/2017/07/31/i-e-and-e-g-youre-not-writing-in-latin-so-why-are-you-using-them/
https://thebettereditor.wordpress.com/2017/07/31/i-e-and-e-g-youre-not-writing-in-latin-so-why-are-you-using-them/
https://www.plagiarism.org/
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